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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Architecture Overview
Each LatticeECP3 device contains an array of logic blocks surrounded by Programmable I/O Cells (PIC). Inter-
spersed between the rows of logic blocks are rows of sysMEM™ Embedded Block RAM (EBR) and rows of sys-
DSP™ Digital Signal Processing slices, as shown in Figure 2-1. The LatticeECP3-150 has four rows of DSP slices; 
all other LatticeECP3 devices have two rows of DSP slices. In addition, the LatticeECP3 family contains SERDES 
Quads on the bottom of the device. 

There are two kinds of logic blocks, the Programmable Functional Unit (PFU) and Programmable Functional Unit 
without RAM (PFF). The PFU contains the building blocks for logic, arithmetic, RAM and ROM functions. The PFF 
block contains building blocks for logic, arithmetic and ROM functions. Both PFU and PFF blocks are optimized for 
flexibility, allowing complex designs to be implemented quickly and efficiently. Logic Blocks are arranged in a two-
dimensional array. Only one type of block is used per row. 

The LatticeECP3 devices contain one or more rows of sysMEM EBR blocks. sysMEM EBRs are large, dedicated 
18Kbit fast memory blocks. Each sysMEM block can be configured in a variety of depths and widths as RAM or 
ROM. In addition, LatticeECP3 devices contain up to two rows of DSP slices. Each DSP slice has multipliers and 
adder/accumulators, which are the building blocks for complex signal processing capabilities.

The LatticeECP3 devices feature up to 16 embedded 3.2 Gbps SERDES (Serializer / Deserializer) channels. Each 
SERDES channel contains independent 8b/10b encoding / decoding, polarity adjust and elastic buffer logic. Each 
group of four SERDES channels, along with its Physical Coding Sub-layer (PCS) block, creates a quad. The func-
tionality of the SERDES/PCS quads can be controlled by memory cells set during device configuration or by regis-
ters that are addressable during device operation. The registers in every quad can be programmed via the 
SERDES Client Interface (SCI). These quads (up to four) are located at the bottom of the devices. 

Each PIC block encompasses two PIOs (PIO pairs) with their respective sysI/O buffers. The sysI/O buffers of the 
LatticeECP3 devices are arranged in seven banks, allowing the implementation of a wide variety of I/O standards. 
In addition, a separate I/O bank is provided for the programming interfaces. 50% of the PIO pairs on the left and 
right edges of the device can be configured as LVDS transmit/receive pairs. The PIC logic also includes pre-engi-
neered support to aid in the implementation of high speed source synchronous standards such as XGMII, 7:1 
LVDS, along with memory interfaces including DDR3.

The LatticeECP3 registers in PFU and sysI/O can be configured to be SET or RESET. After power up and the 
device is configured, it enters into user mode with these registers SET/RESET according to the configuration set-
ting, allowing the device entering to a known state for predictable system function.

Other blocks provided include PLLs, DLLs and configuration functions. The LatticeECP3 architecture provides two 
Delay Locked Loops (DLLs) and up to ten Phase Locked Loops (PLLs). The PLL and DLL blocks are located at the 
end of the EBR/DSP rows. 

The configuration block that supports features such as configuration bit-stream decryption, transparent updates 
and dual-boot support is located toward the center of this EBR row. Every device in the LatticeECP3 family sup-
ports a sysCONFIG™ port located in the corner between banks one and two, which allows for serial or parallel 
device configuration.

In addition, every device in the family has a JTAG port. This family also provides an on-chip oscillator and soft error 
detect capability. The LatticeECP3 devices use 1.2 V as their core voltage.

LatticeECP3 Family Data Sheet
Architecture
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Figure 2-1. Simplified Block Diagram, LatticeECP3-35 Device (Top Level)

PFU Blocks 
The core of the LatticeECP3 device consists of PFU blocks, which are provided in two forms, the PFU and PFF. 
The PFUs can be programmed to perform Logic, Arithmetic, Distributed RAM and Distributed ROM functions. PFF 
blocks can be programmed to perform Logic, Arithmetic and ROM functions. Except where necessary, the remain-
der of this data sheet will use the term PFU to refer to both PFU and PFF blocks. 

Each PFU block consists of four interconnected slices numbered 0-3 as shown in Figure 2-2. Each slice contains 
two LUTs. All the interconnections to and from PFU blocks are from routing. There are 50 inputs and 23 outputs 
associated with each PFU block. 

SERDES/PCS 
CH 3

SERDES/PCS 
CH 2

SERDES/PCS 
CH 1

SERDES/PCS 
CH 0

sysIO
Bank 

7 

sysIO
Bank

2 

sysIO 
Bank 0 

sysIO 
Bank 1 

sysIO Bank 3 sysIO Bank 6 

Configuration Logic: 
Dual-boot, Encryption 
and Transparent Updates

On-chip Oscillator

Pre-engineered Source 
Synchronous Support:
DDR3 - 800 Mbps
Generic - Up to 1 Gbps

Flexible Routing:
Optimized for speed 
and routability

Flexible sysIO:
LVCMOS, HSTL, 
SSTL, LVDS
Up to 486 I/Os

Programmable 
Function Units:
Up to 149K LUTs

sysCLOCK 
PLLs & DLLs:
Frequency Synthesis 
and Clock Alignment

Enhanced DSP 
Slices: Multiply, 
Accumulate and ALU

JTAG

sysMEM Block 
RAM: 18 Kbit

3.2 Gbps SERDES

Note: There is no Bank 4 or Bank 5 in LatticeECP3 devices.
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Figure 2-2. PFU Diagram

Slice 
Slice 0 through Slice 2 contain two LUT4s feeding two registers, whereas Slice 3 contains two LUT4s only. For 
PFUs, Slice 0 through Slice 2 can be configured as distributed memory, a capability not available in the PFF. 
Table 2-1 shows the capability of the slices in both PFF and PFU blocks along with the operation modes they 
enable. In addition, each PFU contains logic that allows the LUTs to be combined to perform functions such as 
LUT5, LUT6, LUT7 and LUT8. There is control logic to perform set/reset functions (programmable as synchronous/
asynchronous), clock select, chip-select and wider RAM/ROM functions. 

Table 2-1. Resources and Modes Available per Slice

Figure 2-3 shows an overview of the internal logic of the slice. The registers in the slice can be configured for posi-
tive/negative and edge triggered or level sensitive clocks.

Slices 0, 1 and 2 have 14 input signals: 13 signals from routing and one from the carry-chain (from the adjacent 
slice or PFU). There are seven outputs: six to routing and one to carry-chain (to the adjacent PFU). Slice 3 has 10 
input signals from routing and four signals to routing. Table 2-2 lists the signals associated with Slice 0 to Slice 2.

Slice

PFU BLock PFF Block

Resources Modes Resources Modes

Slice 0 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 1 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 2 2 LUT4s and 2 Registers Logic, Ripple, RAM, ROM 2 LUT4s and 2 Registers Logic, Ripple, ROM

Slice 3 2 LUT4s Logic, ROM 2 LUT4s Logic, ROM
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Figure 2-10. Primary Clock Sources for LatticeECP3-35

Figure 2-11. Primary Clock Sources for LatticeECP3-70, -95, -150
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ALU Flags
The sysDSP slice provides a number of flags from the ALU including:

• Equal to zero (EQZ)

• Equal to zero with mask (EQZM)

• Equal to one with mask (EQOM)

• Equal to pattern with mask (EQPAT)

• Equal to bit inverted pattern with mask (EQPATB)

• Accumulator Overflow (OVER)

• Accumulator Underflow (UNDER)

• Either over or under flow supporting LatticeECP2 legacy designs (OVERUNDER)

Clock, Clock Enable and Reset Resources
Global Clock, Clock Enable and Reset signals from routing are available to every sysDSP slice. From four clock 
sources (CLK0, CLK1, CLK2, and CLK3) one clock is selected for each input register, pipeline register and output 
register. Similarly Clock Enable (CE) and Reset (RST) are selected at each input register, pipeline register and out-
put register.

Resources Available in the LatticeECP3 Family 
Table 2-9 shows the maximum number of multipliers for each member of the LatticeECP3 family. Table 2-10 shows 
the maximum available EBR RAM Blocks in each LatticeECP3 device. EBR blocks, together with Distributed RAM 
can be used to store variables locally for fast DSP operations. 

Table 2-9. Maximum Number of DSP Slices in the LatticeECP3 Family 

Table 2-10. Embedded SRAM in the LatticeECP3 Family

Device DSP Slices 9x9 Multiplier 18x18 Multiplier 36x36 Multiplier 

ECP3-17 12 48 24 6

ECP3-35 32 128 64 16

ECP3-70 64 256 128 32

ECP3-95 64 256 128 32

ECP3-150 160 640 320 80

Device EBR SRAM Block 
Total EBR SRAM 

(Kbits) 

ECP3-17 38 700

ECP3-35 72 1327

ECP3-70 240 4420

ECP3-95 240 4420

ECP3-150 372 6850
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Programmable I/O Cells (PIC) 
Each PIC contains two PIOs connected to their respective sysI/O buffers as shown in Figure 2-32. The PIO Block 
supplies the output data (DO) and the tri-state control signal (TO) to the sysI/O buffer and receives input from the 
buffer. Table 2-11 provides the PIO signal list.

Figure 2-32. PIC Diagram
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sysI/O Differential Electrical Characteristics
LVDS25

Over Recommended Operating Conditions

Differential HSTL and SSTL
Differential HSTL and SSTL outputs are implemented as a pair of complementary single-ended outputs. All allow-
able single-ended output classes (class I and class II) are supported in this mode.

Parameter Description Test Conditions Min. Typ. Max. Units

VINP
1, VINM

1 Input Voltage 0 — 2.4 V

VCM
1 Input Common Mode Voltage Half the Sum of the Two Inputs 0.05 — 2.35 V

VTHD Differential Input Threshold Difference Between the Two Inputs +/–100 — — mV

IIN Input Current Power On or Power Off — — +/–10 µA

VOH Output High Voltage for VOP or VOM RT = 100 Ohm — 1.38 1.60 V

VOL Output Low Voltage for VOP or VOM RT = 100 Ohm 0.9 V 1.03 — V

VOD Output Voltage Differential (VOP - VOM), RT = 100 Ohm 250 350 450 mV

VOD 
Change in VOD Between High and 
Low — — 50 mV

VOS Output Voltage Offset (VOP + VOM)/2, RT = 100 Ohm 1.125 1.20 1.375 V

VOS Change in VOS Between H and L — — 50 mV

ISAB Output Short Circuit Current VOD = 0V Driver Outputs Shorted to 
Each Other — — 12 mA

1, On the left and right sides of the device, this specification is valid only for VCCIO = 2.5 V or 3.3 V.
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BLVDS25
The LatticeECP3 devices support the BLVDS standard. This standard is emulated using complementary LVCMOS 
outputs in conjunction with a parallel external resistor across the driver outputs. BLVDS is intended for use when 
multi-drop and bi-directional multi-point differential signaling is required. The scheme shown in Figure 3-2 is one 
possible solution for bi-directional multi-point differential signals.

Figure 3-2. BLVDS25 Multi-point Output Example

Table 3-2. BLVDS25 DC Conditions1

Over Recommended Operating Conditions

Parameter Description

Typical

UnitsZo = 45 Zo = 90

VCCIO Output Driver Supply (+/– 5%) 2.50 2.50 V

ZOUT Driver Impedance 10.00 10.00 

RS Driver Series Resistor (+/– 1%) 90.00 90.00 

RTL Driver Parallel Resistor (+/– 1%) 45.00 90.00 

RTR Receiver Termination (+/– 1%) 45.00 90.00 

VOH Output High Voltage 1.38 1.48 V

VOL Output Low Voltage 1.12 1.02 V

VOD Output Differential Voltage 0.25 0.46 V

VCM Output Common Mode Voltage 1.25 1.25 V

IDC DC Output Current 11.24 10.20 mA

1. For input buffer, see LVDS table.

Heavily loaded backplane, effective Zo ~ 45 to 90 Ohms differential
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MLVDS25
The LatticeECP3 devices support the differential MLVDS standard. This standard is emulated using complemen-
tary LVCMOS outputs in conjunction with a parallel resistor across the driver outputs. The MLVDS input standard is 
supported by the LVDS differential input buffer. The scheme shown in Figure 3-5 is one possible solution for 
MLVDS standard implementation. Resistor values in Figure 3-5 are industry standard values for 1% resistors. 

Figure 3-5. MLVDS25 (Multipoint Low Voltage Differential Signaling)

Table 3-5. MLVDS25 DC Conditions1 

Parameter Description

Typical

UnitsZo=50 Zo=70

VCCIO Output Driver Supply (+/–5%) 2.50 2.50 V

ZOUT Driver Impedance 10.00 10.00 

RS Driver Series Resistor (+/–1%) 35.00 35.00 

RTL Driver Parallel Resistor (+/–1%) 50.00 70.00 

RTR Receiver Termination (+/–1%) 50.00 70.00 

VOH Output High Voltage 1.52 1.60 V

VOL Output Low Voltage 0.98 0.90 V

VOD Output Differential Voltage 0.54 0.70 V

VCM Output Common Mode Voltage 1.25 1.25 V

IDC DC Output Current 21.74 20.00 mA

1. For input buffer, see LVDS table.
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tHPLL
Clock to Data Hold - PIO Input 
Register ECP3-70EA/95EA 0.7 — 0.7 — 0.8 — ns

tSU_DELPLL
Clock to Data Setup - PIO Input 
Register with Data Input Delay ECP3-70EA/95EA 1.6 — 1.8 — 2.0 — ns

tH_DELPLL
Clock to Data Hold - PIO Input 
Register with Input Data Delay ECP3-70EA/95EA 0.0 — 0.0 — 0.0 — ns

tCOPLL
Clock to Output - PIO Output 
Register ECP3-35EA — 3.2 — 3.4 — 3.6 ns

tSUPLL
Clock to Data Setup - PIO Input 
Register ECP3-35EA 0.6 — 0.7 — 0.8 — ns

tHPLL
Clock to Data Hold - PIO Input 
Register ECP3-35EA 0.3 — 0.3 — 0.4 — ns

tSU_DELPLL
Clock to Data Setup - PIO Input 
Register with Data Input Delay ECP3-35EA 1.6 — 1.7 — 1.8 — ns

tH_DELPLL
Clock to Data Hold - PIO Input 
Register with Input Data Delay ECP3-35EA 0.0 — 0.0 — 0.0 — ns

tCOPLL
Clock to Output - PIO Output 
Register ECP3-17EA — 3.0 — 3.3 — 3.5 ns

tSUPLL
Clock to Data Setup - PIO Input 
Register ECP3-17EA 0.6 — 0.7 — 0.8 — ns

tHPLL
Clock to Data Hold - PIO Input 
Register ECP3-17EA 0.3 — 0.3 — 0.4 — ns

tSU_DELPLL
Clock to Data Setup - PIO Input 
Register with Data Input Delay ECP3-17EA 1.6 — 1.7 — 1.8 — ns

tH_DELPLL
Clock to Data Hold - PIO Input 
Register with Input Data Delay ECP3-17EA 0.0 — 0.0 — 0.0 — ns

Generic DDR12

Generic DDRX1 Inputs with Clock and Data (>10 Bits Wide) Centered at Pin (GDDRX1_RX.SCLK.Centered) Using PCLK Pin for Clock 
Input

tSUGDDR Data Setup Before CLK All ECP3EA Devices 480 — 480 — 480 — ps

tHOGDDR Data Hold After CLK All ECP3EA Devices 480 — 480  — 480 — ps

fMAX_GDDR DDRX1 Clock Frequency All ECP3EA Devices — 250 — 250 — 250 MHz

Generic DDRX1 Inputs with Clock and Data (>10 Bits Wide) Aligned at Pin (GDDRX1_RX.SCLK.PLL.Aligned) Using PLLCLKIN Pin for 
Clock Input

Data Left, Right, and Top Sides and Clock Left and Right Sides

tDVACLKGDDR Data Setup Before CLK All ECP3EA Devices — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK All ECP3EA Devices 0.775 — 0.775 — 0.775 — UI

fMAX_GDDR DDRX1 Clock Frequency All ECP3EA Devices — 250 — 250 — 250 MHz

Generic DDRX1 Inputs with Clock and Data (>10 Bits Wide) Aligned at Pin (GDDRX1_RX.SCLK.Aligned) Using DLL - CLKIN Pin for 
Clock Input

Data Left, Right and Top Sides and Clock Left and Right Sides

tDVACLKGDDR Data Setup Before CLK All ECP3EA Devices — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK All ECP3EA Devices 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX1 Clock Frequency All ECP3EA Devices — 250 — 250 — 250 MHz

Generic DDRX1 Inputs with Clock and Data (<10 Bits Wide) Centered at Pin (GDDRX1_RX.DQS.Centered)  Using DQS Pin for Clock 
Input

tSUGDDR Data Setup After CLK All ECP3EA Devices 535 — 535 — 535 — ps

tHOGDDR Data Hold After CLK All ECP3EA Devices 535 — 535  — 535 — ps

fMAX_GDDR DDRX1 Clock Frequency All ECP3EA Devices — 250 — 250 — 250 MHz

Generic DDRX1 Inputs with Clock and Data (<10bits wide) Aligned at Pin (GDDRX1_RX.DQS.Aligned) Using DQS Pin for Clock Input

Data and Clock Left and Right Sides

tDVACLKGDDR Data Setup Before CLK All ECP3EA Devices — 0.225 — 0.225 — 0.225 UI

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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DLL Timing
Over Recommended Operating Conditions

Parameter Description Condition Min. Typ. Max. Units 

fREF 
Input reference clock frequency (on-chip or 
off-chip)  133 — 500 MHz 

fFB Feedback clock frequency (on-chip or off-chip)  133 — 500 MHz 

fCLKOP
1 Output clock frequency, CLKOP  133 — 500 MHz 

fCLKOS
2 Output clock frequency, CLKOS  33.3 — 500 MHz 

tPJIT Output clock period jitter (clean input)   — 200 ps p-p 

tDUTY 

Output clock duty cycle (at 50% levels, 50% duty 
cycle input clock, 50% duty cycle circuit turned 
off, time reference delay mode) 

Edge Clock 40  60 % 

Primary Clock 30  70 % 

tDUTYTRD 

Output clock duty cycle (at 50% levels, arbitrary 
duty cycle input clock, 50% duty cycle circuit 
enabled, time reference delay mode) 

Primary Clock < 250 MHz 45  55 % 

Primary Clock 250 MHz 30  70 % 

Edge Clock 45  55 % 

tDUTYCIR 

Output clock duty cycle (at 50% levels, arbitrary 
duty cycle input clock, 50% duty cycle circuit 
enabled, clock injection removal mode) with DLL 
cascading

Primary Clock < 250 MHz 40  60 % 

Primary Clock  250 MHz 30  70 % 

Edge Clock 45  55 % 

tSKEW
3 Output clock to clock skew between two outputs 

with the same phase setting  — — 100 ps 

tPHASE 
Phase error measured at device pads between 
off-chip reference clock and feedback clocks  — — +/-400 ps 

tPWH 
Input clock minimum pulse width high (at 80% 
level)  550 — — ps 

tPWL Input clock minimum pulse width low (at 20% 
level)  550 — — ps 

tINSTB Input clock period jitter  — — 500 ps

tLOCK DLL lock time  8 — 8200 cycles 

tRSWD Digital reset minimum pulse width (at 80% level)  3 — — ns 

tDEL Delay step size  27 45 70 ps 

tRANGE1 
Max. delay setting for single delay block 
(64 taps)  1.9 3.1 4.4 ns 

tRANGE4 Max. delay setting for four chained delay blocks  7.6 12.4 17.6 ns 

1. CLKOP runs at the same frequency as the input clock.
2. CLKOS minimum frequency is obtained with divide by 4.
3. This is intended to be a “path-matching” design guideline and is not a measurable specification.
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Table 3-7. Channel Output Jitter

Description Frequency Min. Typ. Max. Units

Deterministic 3.125 Gbps — — 0.17 UI, p-p

Random 3.125 Gbps — — 0.25 UI, p-p

Total 3.125 Gbps — — 0.35 UI, p-p

Deterministic 2.5 Gbps — — 0.17 UI, p-p

Random 2.5 Gbps — — 0.20 UI, p-p

Total 2.5 Gbps — — 0.35 UI, p-p

Deterministic 1.25 Gbps — — 0.10 UI, p-p

Random 1.25 Gbps — — 0.22 UI, p-p

Total 1.25 Gbps — — 0.24 UI, p-p

Deterministic 622 Mbps — — 0.10 UI, p-p

Random 622 Mbps — — 0.20 UI, p-p

Total 622 Mbps — — 0.24 UI, p-p

Deterministic 250 Mbps — — 0.10 UI, p-p

Random 250 Mbps — — 0.18 UI, p-p

Total 250 Mbps — — 0.24 UI, p-p

Deterministic 150 Mbps — — 0.10 UI, p-p

Random 150 Mbps — — 0.18 UI, p-p

Total 150 Mbps — — 0.24 UI, p-p

Note: Values are measured with PRBS 27-1, all channels operating, FPGA logic active, I/Os around SERDES pins quiet, 
reference clock @ 10X mode.
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SERDES High Speed Data Receiver 
Table 3-9. Serial Input Data Specifications

Input Data Jitter Tolerance
A receiver’s ability to tolerate incoming signal jitter is very dependent on jitter type. High speed serial interface stan-
dards have recognized the dependency on jitter type and have specifications to indicate tolerance levels for differ-
ent jitter types as they relate to specific protocols. Sinusoidal jitter is considered to be a worst case jitter type. 

Table 3-10. Receiver Total Jitter Tolerance Specification

Symbol Description Min. Typ. Max. Units

RX-CIDS
Stream of nontransitions1 
(CID = Consecutive Identical Digits) @ 10-12 BER

3.125 G — — 136

Bits 

2.5 G — — 144

1.485 G — — 160

622 M — — 204

270 M — — 228

150 M — — 296

VRX-DIFF-S Differential input sensitivity 150 — 1760 mV, p-p 

VRX-IN Input levels 0 — VCCA +0.54 V

VRX-CM-DC Input common mode range (DC coupled) 0.6 — VCCA V 

VRX-CM-AC Input common mode range (AC coupled)3 0.1 — VCCA +0.2 V

TRX-RELOCK SCDR re-lock time2 — 1000 — Bits

ZRX-TERM Input termination 50/75 Ohm/High Z –20% 50/75/HiZ +20% Ohms

RLRX-RL Return loss (without package) 10 — — dB

1. This is the number of bits allowed without a transition on the incoming data stream when using DC coupling.
2. This is the typical number of bit times to re-lock to a new phase or frequency within +/– 300 ppm, assuming 8b10b encoded data.
3. AC coupling is used to interface to LVPECL and LVDS. LVDS interfaces are found in laser drivers and Fibre Channel equipment. LVDS inter-

faces are generally found in 622 Mbps SERDES devices.
4. Up to 1.76 V.

Description Frequency Condition Min. Typ. Max. Units

Deterministic

3.125 Gbps

600 mV differential eye — — 0.47 UI, p-p 

Random 600 mV differential eye — — 0.18 UI, p-p 

Total 600 mV differential eye — — 0.65 UI, p-p 

Deterministic

2.5 Gbps

600 mV differential eye — — 0.47 UI, p-p 

Random 600 mV differential eye — — 0.18 UI, p-p 

Total 600 mV differential eye — — 0.65 UI, p-p 

Deterministic

1.25 Gbps

600 mV differential eye — — 0.47 UI, p-p 

Random 600 mV differential eye — — 0.18 UI, p-p 

Total 600 mV differential eye — — 0.65 UI, p-p 

Deterministic

622 Mbps

600 mV differential eye — — 0.47 UI, p-p 

Random 600 mV differential eye — — 0.18 UI, p-p 

Total 600 mV differential eye — — 0.65 UI, p-p 

Note: Values are measured with CJPAT, all channels operating, FPGA Logic active, I/Os around SERDES pins quiet, voltages are nominal, 
room temperature.
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HDMI (High-Definition Multimedia Interface) Electrical and Timing 
Characteristics
AC and DC Characteristics
Table 3-22. Transmit and Receive1, 2

Symbol Description

Spec. Compliance

UnitsMin. Spec. Max. Spec.

Transmit

Intra-pair Skew — 75 ps

Inter-pair Skew — 800 ps

TMDS Differential Clock Jitter — 0.25 UI

Receive

RT Termination Resistance 40 60 Ohms

VICM
Input AC Common Mode Voltage (50-Ohm Set-
ting) — 50 mV

TMDS Clock Jitter Clock Jitter Tolerance — 0.25 UI

1. Output buffers must drive a translation device. Max. speed is 2 Gbps. If translation device does not modify rise/fall time, the maximum 
speed is 1.5 Gbps.

2. Input buffers must be AC coupled in order to support the 3.3 V common mode. Generally, HDMI inputs are terminated by an external cable 
equalizer before data/clock is forwarded to the LatticeECP3 device.
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[LOC]DQS[num] I/O DQ input/output pads: T (top), R (right), B (bottom), L (left), DQS, num = ball 
function number.

[LOC]DQ[num] I/O DQ input/output pads: T (top), R (right), B (bottom), L (left), DQ, associated 
DQS number.

Test and Programming (Dedicated Pins)

TMS I Test Mode Select input, used to control the 1149.1 state machine. Pull-up is 
enabled during configuration. 

TCK I Test Clock input pin, used to clock the 1149.1 state machine. No pull-up 
enabled. 

TDI I 

Test Data in pin. Used to load data into device using 1149.1 state machine. 
After power-up, this TAP port can be activated for configuration by sending 
appropriate command. (Note: once a configuration port is selected it is 
locked. Another configuration port cannot be selected until the power-up 
sequence). Pull-up is enabled during configuration. 

TDO O Output pin. Test Data Out pin used to shift data out of a device using 1149.1. 

VCCJ — Power supply pin for JTAG Test Access Port. 

Configuration Pads (Used During sysCONFIG)

CFG[2:0] I 
Mode pins used to specify configuration mode values latched on rising edge 
of INITN. During configuration, a pull-up is enabled. These are dedicated 
pins. 

INITN I/O Open Drain pin. Indicates the FPGA is ready to be configured. During config-
uration, a pull-up is enabled. It is a dedicated pin. 

PROGRAMN I Initiates configuration sequence when asserted low. This pin always has an 
active pull-up. It is a dedicated pin. 

DONE I/O Open Drain pin. Indicates that the configuration sequence is complete, and 
the startup sequence is in progress. It is a dedicated pin. 

CCLK I Input Configuration Clock for configuring an FPGA in Slave SPI, Serial, and 
CPU modes. It is a dedicated pin.

MCLK I/O Output Configuration Clock for configuring an FPGA in SPI, SPIm, and Mas-
ter configuration modes.

BUSY/SISPI O Parallel configuration mode busy indicator. SPI/SPIm mode data output. 

CSN/SN/OEN I/O Parallel configuration mode active-low chip select. Slave SPI chip select. 
Parallel burst Flash output enable.

CS1N/HOLDN/RDY I Parallel configuration mode active-low chip select. Slave SPI hold input. 

WRITEN I Write enable for parallel configuration modes.

DOUT/CSON/CSSPI1N O Serial data output. Chip select output. SPI/SPIm mode chip select.

D[0]/SPIFASTN I/O

sysCONFIG Port Data I/O for Parallel mode. Open drain during configuration.

sysCONFIG Port Data I/O for SPI or SPIm. When using the SPI or SPIm 
mode, this pin should either be tied high or low, must not be left floating. Open 
drain during configuration.

D1 I/O Parallel configuration I/O. Open drain during configuration.

D2 I/O Parallel configuration I/O. Open drain during configuration.

D3/SI I/O Parallel configuration I/O. Slave SPI data input. Open drain during configura-
tion.

D4/SO I/O Parallel configuration I/O. Slave SPI data output. Open drain during configura-
tion.

D5 I/O Parallel configuration I/O. Open drain during configuration.

D6/SPID1 I/O Parallel configuration I/O. SPI/SPIm data input. Open drain during configura-
tion.

Signal Descriptions (Cont.)
Signal Name I/O Description 
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PICs and DDR Data (DQ) Pins Associated with the DDR Strobe (DQS) Pin
PICs Associated with 

DQS Strobe PIO Within PIC
DDR Strobe (DQS) and 

Data (DQ) Pins

For Left and Right Edges of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ

B DQ 

P[Edge] [n] 
A [Edge]DQSn

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

For Top Edge of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ 

B DQ 

P[Edge] [n] 
A [Edge]DQSn 

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

Note: “n” is a row PIC number. 
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-150EA-6FN672C 1.2 V –6 STD Lead-Free fpBGA 672 COM 149

LFE3-150EA-7FN672C 1.2 V –7 STD Lead-Free fpBGA 672 COM 149

LFE3-150EA-8FN672C 1.2 V –8 STD Lead-Free fpBGA 672 COM 149

LFE3-150EA-6LFN672C 1.2 V –6 LOW Lead-Free fpBGA 672 COM 149

LFE3-150EA-7LFN672C 1.2 V –7 LOW Lead-Free fpBGA 672 COM 149

LFE3-150EA-8LFN672C 1.2 V –8 LOW Lead-Free fpBGA 672 COM 149

LFE3-150EA-6FN1156C 1.2 V –6 STD Lead-Free fpBGA 1156 COM 149

LFE3-150EA-7FN1156C 1.2 V –7 STD Lead-Free fpBGA 1156 COM 149

LFE3-150EA-8FN1156C 1.2 V –8 STD Lead-Free fpBGA 1156 COM 149

LFE3-150EA-6LFN1156C 1.2 V –6 LOW Lead-Free fpBGA 1156 COM 149

LFE3-150EA-7LFN1156C 1.2 V –7 LOW Lead-Free fpBGA 1156 COM 149

LFE3-150EA-8LFN1156C 1.2 V –8 LOW Lead-Free fpBGA 1156 COM 149

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.

Part Number Voltage Grade Power Package Pins Temp. LUTs (K)

LFE3-150EA-6FN672CTW1 1.2 V –6 STD Lead-Free fpBGA 672 COM 149

LFE3-150EA-7FN672CTW1 1.2 V –7 STD Lead-Free fpBGA 672 COM 149

LFE3-150EA-8FN672CTW1 1.2 V –8 STD Lead-Free fpBGA 672 COM 149

LFE3-150EA-6FN1156CTW1 1.2 V –6 STD Lead-Free fpBGA 1156 COM 149

LFE3-150EA-7FN1156CTW1 1.2 V –7 STD Lead-Free fpBGA 1156 COM 149

LFE3-150EA-8FN1156CTW1 1.2 V –8 STD Lead-Free fpBGA 1156 COM 149

1. Note: Specifications for the LFE3-150EA-spFNpkgCTW and LFE3-150EA-spFNpkgITW devices, (where sp is the speed and 
pkg is the package), are the same as the LFE3-150EA-spFNpkgC and LFE3-150EA-spFNpkgI devices respectively, except 
as specified below.

• The CTC (Clock Tolerance Circuit) inside the SERDES hard PCS in the TW device is not functional but it can be bypassed 
and implemented in soft IP.

•  The SERDES XRES pin on the TW device passes CDM testing at 250 V.
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Industrial

The following devices may have associated errata. Specific devices with associated errata will be notated with a 
footnote.

Part Number Voltage Grade Power Package1 Pins Temp. LUTs (K) 

LFE3-17EA-6FTN256I 1.2 V –6 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-7FTN256I 1.2 V –7 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-8FTN256I 1.2 V –8 STD Lead-Free ftBGA 256 IND 17

LFE3-17EA-6LFTN256I 1.2 V –6 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-7LFTN256I 1.2 V –7 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-8LFTN256I 1.2 V –8 LOW Lead-Free ftBGA 256 IND 17

LFE3-17EA-6MG328I 1.2 V –6 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-7MG328I 1.2 V –7 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-8MG328I 1.2 V –8 STD Lead-Free csBGA 328 IND 17

LFE3-17EA-6LMG328I 1.2 V –6 LOW Green csBGA 328 IND 17

LFE3-17EA-7LMG328I 1.2 V –7 LOW Green csBGA 328 IND 17

LFE3-17EA-8LMG328I 1.2 V –8 LOW Green csBGA 328 IND 17

LFE3-17EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 17

LFE3-17EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 17

LFE3-17EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 17

LFE3-17EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 17

1. Green = Halogen free and lead free.

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-35EA-6FTN256I 1.2 V –6 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-7FTN256I 1.2 V –7 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-8FTN256I 1.2 V –8 STD Lead-Free ftBGA 256 IND 33

LFE3-35EA-6LFTN256I 1.2 V –6 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-7LFTN256I 1.2 V –7 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-8LFTN256I 1.2 V –8 LOW Lead-Free ftBGA 256 IND 33

LFE3-35EA-6FN484I 1.2 V –6 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-7FN484I 1.2 V –7 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-8FN484I 1.2 V –8 STD Lead-Free fpBGA 484 IND 33

LFE3-35EA-6LFN484I 1.2 V –6 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-7LFN484I 1.2 V –7 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-8LFN484I 1.2 V –8 LOW Lead-Free fpBGA 484 IND 33

LFE3-35EA-6FN672I 1.2 V –6 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-7FN672I 1.2 V –7 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-8FN672I 1.2 V –8 STD Lead-Free fpBGA 672 IND 33

LFE3-35EA-6LFN672I 1.2 V –6 LOW Lead-Free fpBGA 672 IND 33

LFE3-35EA-7LFN672I 1.2 V –7 LOW Lead-Free fpBGA 672 IND 33

LFE3-35EA-8LFN672I 1.2 V –8 LOW Lead-Free fpBGA 672 IND 33

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.
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Updated Frequency to 150 Mbps in Table 3-11 Periodic Receiver Jitter 
Tolerance Specification

December 2010 01.7EA Multiple Data sheet made final. Removed “preliminary” headings.

Removed data for 70E and 95E devices. A separate data sheet is avail-
able for these specific devices.

Updated for Lattice Diamond design software.

Introduction Corrected number of user I/Os

Architecture Corrected the package type in Table 2-14 Available SERDES Quad per 
LatticeECP3 Devices. 

Updated description of General Purpose PLL

Added additional information in the Flexible Quad SERDES Architecture 
section.

Added footnotes and corrected the information in Table 2-16 Selectable 
master Clock (MCCLK) Frequencies During Configuration (Nominal).

Updated Figure 2-16, Per Region Secondary Clock Selection.

Updated description for On-Chip Programmable Termination.

Added information about number of rows of DSP slices.

Updated footnote 2 for Table 2-12, On-Chip Termination Options for 
Input Modes.

Updated information for sysIO buffer pairs.

Corrected minimum number of General Purpose PLLs (was 4, now 2).

DC and Switching 
Characteristics

Regenerated sysCONFIG Port Timing figure.

Added tW (clock pulse width) in External Switching Characteristics 
table.

Corrected units, revised and added data, and corrected footnote 1 in 
External Switching Characteristics table.

Added Jitter Transfer figures in SERDES External Reference Clock sec-
tion.

Corrected capacitance information in the DC Electrical Characteristics 
table.

Corrected data in the Register-to-Register Performance table.

Corrected GDDR Parameter name HOGDDR.

Corrected RSDS25 -7 data in Family Timing Adders table.

Added footnotes 10-12 to DDR data information in the External Switch-
ing Characteristics table.

Corrected titles for Figures 3-7 (DDR/DDR2/DDR3 Parameters) and 
3-8 (Generic DDR/DDRX2 Parameters).

Updated titles for Figures 3-5 (MLVDS25 (Multipoint Low Voltage Differ-
ential Signaling)) and 3-6 (Generic DDRX1/DDRX2 (With Clock and 
Data Edges Aligned)).

Updated Supply Current table.

Added GDDR interface information to the External Switching and Char-
acteristics table.

Added footnote to sysIO Recommended Operating Conditions table.

Added footnote to LVDS25 table.

Corrected DDR section footnotes and references.

Corrected Hot Socketing support from “top and bottom banks” to “top 
and bottom I/O pins”.

Pinout Information Updated description for VTTx.

Date Version Section Change Summary


